Entering a partial title (e.g. on/y one word) is acceptable, but may result in
multiple matches being found. To scroll through any matches click the ‘Find
Next’ button on the prompt. The matches found will be highlighted in the
main dialogue screen. If no matches are found you will receive an error
messa ge.

To finish searching press the ‘Cancel’ button. This will exit the Search
dialogue, but will leave the last match highlighted.

This function will be disabled if no CDs are registered with 205 s database.

7.3.2. Search Audio Track

This button allows a search through all the individual track titles registered

with  DDS. Track titles will only be registered if they have been manually
entered (see under Tools for information on entering  track titles.) This
feature functions in a similar manner to the Searckh CD 7itlebutton.

This function will be disabled if no Audio CDs are registered with the DDS
database.

7.4. Tracking CDs
When ejecting a CD the following prompt will appear:

DDS Question

Do you want to sjgct the CD "3rd Party Chipset Series Mainboard Utility CD [ Wer 1.4 1" fram
CCD Unit "hy CCD™7

For wham: I

Yes No

If a name is typed into the “For whom” box, that name will then appear in
the “Ejected For” column:

‘.-_IEI_I.EI

File Search  Tools

Status Ejected For

{NOWIN CD AUDIO br. Srnith
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8.

8.1.

®

Using the Drop Down Menus

The File Menu

This menu drops down to reveal three sub-items:

['EE' Seach Tools
Backup Databaze ey
Restore Databaze —

Lloze

e
8.1.1. Backup Database

lf you have set the Super’ password you will require it to perform this
operation.

You can use this function to backup the 205 database to any storage med ia.
The database should be backed up periodically to avoid re-entering every
CD in the event of data loss. It is also useful for moving a CCD unit between
computers (sece Restore Database for more details.)

Selecting this menu item causes the following dialogue to appear on the
screen:

DDS Backup Dialog Bz

Destination Diive : !A -

Select Unit Mame: |01z -

Ok I LCancel i

You may now select whether you want to backup ‘All Units’ or a ‘Single
Unit.” Normally all units should be backed up. You may also choose which
destination drive to use. The database should be stored on removable media
drive (e.g. a floppy disk or CD-R disk) to protect it from local disk failures.

Click OK to backup your database.
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8.1.2  Restore Database

lf you have set the Super’  password you will require it to perform this
operation.

Choosing this option causes the following dialogue to appear:

DDS Restore Backup Dialog x|

Source Drive IA 'i

Select Unit Name : | 0115

—Restore

1+ Al avallable Backups
" Single Unit Backup

OK I Cancel |

For a normal restoration (ie. if not moving units between PCs) make sure
‘All Available Backups’ is selected. Choose the drive on which you saved
your backup from the drop down list.

1t is highly recommended that you perform the Verify All Empty Slots
Junction after restoring as your database may have changed.

8.1.2.1. Moving Units Between PCs

You can move the C'CDunit from one computer to another by using the
Backup Database and Restore Database options as such:

1.  On the first PC, use the Backup Database function, and save to a
removable or network drive.

Detach the CCDunit from the first PC.

Attach and configure the C'C’D unit on the second PC.

Install 2DS on the second PC (if not already installed.)

Insert the disk with the database into the second PC (if
applicable.)

Use the Restore Database function on the second PC.

Select the drive on which your backup is stored and click OK.

N

~Es

lf vou have many CCD units and are only moving one, it is recommended
that you choose the ‘Backup Single Unit’ and ‘Restore Single Unit Backup’
options in the Backup and Restore dialogues respectively. This will limit
the size of the backup.
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8.1.22. Moving CCDs to a PCwith Units already attached

If the situation arises where units are to be moved to a PC that already has
CCD units attached to it, it is advisable to keep the database of the CCDunit

in transit in a separate location to the backups of the existing units on the
target PC.

An illustration is where a CCDis being moved from PC 4 to PC £, and a
floppy disk labeled ‘database backups’ has been used to store backups for
PC £. In this situation the ‘database backups’ floppy should NOT be used to
transfer the databases between PCs, as this may cause the current database

on PC A to be accidentally overwritten with an old copy. A new disk should
be used instead.

8.1.2.3. Restoring Single Unit Backups

If you wish to backup and restore only a single unit (e.g. to move it between
PCs) you may find that the name of your CCD unit as it was when you made
the backup, and as it is when you restore the backup, is different. This may
be because you have given the unit a different name on the second PC (if

moving PCs) or because the unit’s name has changed for other reasons in the
meantime.

If such a situation arises, simply choose the name of the unit as it appears on

your Restore dialogue’s drop down list. The DDS software will have
recorded the unit’s in-built serial number during the backup, and will use this
to restore to the correct unit.

813  Close

This option has the same functionality as the ‘Close’ button on the main
dialogue screen.
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8.2. Search

Fil= ! Search Tools
Tit Search CD Title
Py Search Mest CO Title £
g Search Audio Track
Search Nest Audio Track  F4

821 Search CD 7itle
This function is identical to the Search CD Title button on the main
interface (see Using the Software.)

il P | |

822  Search Next CD Title

This function finds the next matching case of a search performed using the
Search CD Title item.

8.2.3.  Search Audio Track

This function is identical to the Search Audio Track button on the main
interface (see Using the Software.)

8.2.4  Search Next Audio Track

This function finds the next matching case of a search performed using the
Search Audio Track item.
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8.3. Tools

File  Search | Tools 5
Tile b S
Bya Add New CD ]
“9 cC Madify CO Infa ]

Merify Al Empty Slats

Wiew Audio Tracks List
Edit Audio Tracks List

Remave E0 Bermarently
Femaove &l CDs Pemanently

Bename CCD Unit
Femaowe CCD Unit Permanently

DDS Options
Super Password

8.3.1. Font
This item allows the display font for 225 to be resized. The options are:

Small, Default, Medium and Large. Alter these to suit your screen size.

8.3.2. Add New CD
This item is identical in function to the Add New CD button (see Using the
Software.)

833  Modify CD Info

This option allows the name, type and password protection status of a CD to
be altered. To perform this operation on a password protected CD, you will
require the appropriate password.

This option will be disabled if no CD is selected.

8.3.4. Verify All Empty Slots

This function can be used to check any slots that the software may be
incorrectly reporting as empty. This situation may arise if a CD is inserted in
the CCDunit when it is not connected to the PC or the PC is not powered
on, or if the DS database is incorrectly altered. Selecting this option will
cause the CCPDunit to perform a self-dia gnostic, which may take a few
minutes.
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8.3.5. View Audio Tracks List

Selecting this option will display a list of the audio tracks for the currently
selected CD.

Love Inc / You're A Superstar Tracks

Henormania Fadio Edit

EBroken Bones [Ruff Diriverz Pickin' & Few Things L
Henomania Club ki

City OF Lave Club ki

Scotty Marz Vocal Mix

kdy riews Track

This option is disabled if there is no currently selected CD, or if the currently
selected CD is not an audio CD with tracks registered in the D/ database.

8.3.6. Edit Audio Tracks List

Selecting this option allows you to edit the audio track list of the selected
CD.

Love Inc / You're A Superstar’s Tracks. il

Trackld

Track02 IBrnken Bones [Ruff Driverz Pickin' & Few Things Up At The Chemiz

Track03 |><enomania Club Mix

TrackO4 ICil_l,l OF Love Club Mix

Trackls IScott_l,l Marz Vocal Mix

TrackOE |My new Track

Track(7? |

TrackOs

Track10

|
Track0d |
|
|

Track1d

QK I <2 Back | Mext > | Cancel |

This option will be disabled if no CD is selected, or if the selected CD is not
an Audio CD.
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8.3.7. Remove CD Permanently

This function will remove the currently selected CD from the 22§ database.
DDS removes this CD from the list and if it is present in the CCDunit then it
is ejected automatically.

lf the selected CD is password protected, the password will be required to
perform this operation.

8.3.8. Remove All CDs Permanently

This option removes all CDs from the database. This option may be useful
when the use of the CCDunit is completely altered, for instance from storing
only Audio CDs to storing only Data CDs. Any CDs inside the unit will be
automatically ejected.

lf you have set the Super’  password you will require it to perform this
operation.

839 Rename CCD Unir

Using this option a unit can be given a more descriptive name. This is
particularly useful for users with more than one unit.

lfvou have set the Super’ password you will require it to perform this
operation.

8.3.10. Remove CCD Unit Permanently

This option allows a unit to be permanently removed from the DDS
database. This will erase all records associated with the unit, including all the
CDs it contains. This option is useful when a CCD unit has been
permanently relocated to another computer. In order for this function to
execute, the relevant unit must be disconnected from the computer.

lf vou have set the Super’  password you will require it to perform this
operation.
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8.3.11. DDS Options

This selection brings up the following dialogue box:

DDS : Dptions

~ Preference
¥ automatically detect CDs in CO-ROM.
¥ Remind user to replace ejected CDs, after; II-S‘U—E seconds.
W Farce name entry on CD remaoval.
Language i English :j

~ Connection

Connect CCD Unit [11SE 'i Paort Com Paort Mumber | | V!
Gel CCD(s) Info | ok | Cancel |

The options function as follows:

Automatically detect CD in CD-ROM: clearing this check box prevents
DDS from scanning the PC’s CD-ROM drive for new CDs. This effectively
disables the Automatic Recognition method of adding CDs to the database.
Clearing this option automatically clears the ‘Remind user to replace ejected
CDs’ option.

Remind user to replace ejected CDs: this option controls the reminder to
replace a CD into the CCD unit after ejection from the CD-ROM drive. The
time period between reminders can also be varied from 20 to 180 seconds.
(See Re-Insertion Reminder under Operational Features for more

details.) Ticking this option automatically ticks the ‘Automatically detect CD
in CD-ROM’ option.

Force name entry on CD removal: if enabled, this option forces a name to
be entered before allowing a CD to be ejected. (See Tracking CDs.)

Language: alternates between supported languages. Changing this option to
a language your operating system does not support may render the interface
illegible.

Connect CCD Unit: This option toggles between having the CCDunit(s)
connected via a USB cable or a COM (RS232) cable. This option should not
be changed if the connection type has not been altered.

Get CCD(s) Info: This will display a list of all units in the database,
including some basic information on each unit.
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9. Password Protection

9.1.

9.2

A\

9.3.

About Password Protection

91.1. What is password protection?

DDS includes features to password protect your CDs. Once a CD is
password protected, the password assigned to it is required to eject the CD,
or to perform any modifications to its database record.

There are two levels of password protection: individual CD passwords and
the ‘Super’ password. The ‘Super’ password exists to protect administrative
functions, such as backing up databases or removing units permanently, and
also to override other passwords if necessary.

91.2. Why should I use password protection?

Password protection is useful in a multi-user home or office environment,
where it may not be desirable to share all CDs with all users. If a certain CD

contains sensitive information, the password protection feature can limit
access to it.

Limitations of Password Protection

The CCD unit is not built to withstand attempts at CD thefi. It is not

tamper proof or tamper evident. A CCD unit can easily be removed fiom
your computer if not secured by external means.

Due to these limitations, a CCD should not be used as a replacement for a

safe or other high security device. The password protection feature is
intended to restrict day-to-day use, not to protect highly sensitive or valuable

information.  Project Lab Prty. Lid. accepts no responsibility for information
stolen or otherwise removed from a CCD unit.

Using Passwords

93.1. Setting/Removing the ‘Super’ Password

The “Super’ password may be set during the installation process (see
Software Installation) or, if you choose to skip the password set-up by
pressing Cancel, you may set-up the password at any time afterwards by
clicking the Tool menu and choosing the Super Password option.

You will be prompted to set up the ‘Super’ password if you attempt to
password protect any CD.
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The ‘Super’ password must be at least 4 characters long.

To turn password protection off, choose the Super Password option from
the Tools menu. In the ‘Modify Super Password’ dialogue, type your old
password in the ‘Old password’ dialogue but leave the other two fields
blank.

Caution. turning your Super’ password off will erase all your CD
Passwords.

93.2.  Protecting the ‘Super’ Password
Access to the ‘Super’ password enables a user to perform all administrative

functions on DS, as well as allowing them to eject all password protected
CDs.

For this reason, the ‘Super’ password should be kept secret from all non-
administrative users. Do not write the ‘Super’ password on or near your PC
or CCPDunit. Do not use an obvious or easily guessable password.

93.3. Using the ‘Super’ Password

Once set, your ‘Super’ password will be required to perform the following
functions on @/ CCDunits: Remove CCD Unit Permanently, Rename CCD
Unit, Backup Database, Restore Database & Remove A/l CDs Permanently.

Your ‘Super’ password may also be used to eject or modify information for
password protected CDs. This is useful if a specific CD password is lost or
forgotten. To use the ‘Super’ password in this manner, simply type it instead
of the CD password when prompted.

93.4. Setting/ Removing CD Passwords

Individual CD passwords may be set when a CD is added to the database, by
ticking the Security box and typing the password in the provided areas.

A password may also be set or removed by choosing Medify CD Info from
the Tools menu. Once in the Modify CD Info dialogue, password protection
may be activated or deactivated by tick ing the Security box and typing the
password in the appropriate areas.

93.5. Using CD Passwords

Once set, a CD’s password will be needed every time that CD is ejected or
has its information modified. To use the password, simply type it in when
prompted by DDS.
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10. Operational Features

10.1. General Operation

When a CD is inserted into the CCDunit, DDS will react according to the
status of ejected CDs:

. If no registered CD is outside the C'C’Dunit the disk will be assumed
to be a new addition and a name will be requested.

. If one or more registered CDs are outside the unit then a list of names
will be provided for selection. If the database is not full an option will
also be provided to add a new CD.

10.2. Ejection Confirmation

Whenever DDS'is asked to eject a CD, it will prompt the user to ensure that

the correct disk has been ejected. If the user answers ‘Yes’ then operation
will continue as normal However, if it is the incorrect CD then 20§ will
request that the ejected disk be identified from a list and re-inserted. This
procedure will be repeated with every disk until the correct CD is found.

10.3. Re-insertion Reminder

If a CD that is registered with 205 is removed from the CD-ROM and not
promptly re-inserted into the C'CD unit, a prompt appears to remind the user:

| :DDS Reminder....

If you select ‘No’ the message appears again every 60 seconds (by default)
until the CD is re-inserted into the CCPDunit or the CD-ROM drive. To
prevent the message from re-appearing select ‘Yes’ when prompted. To
prevent all CD replacement reminders disable the ‘Remind User to Re-
insert CD’ option (see DDS Options under Tools for details.)
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10.4. Duplicate CDs

If the user inserts a CD into the PC’s CD-ROM drive, and the software
believes that CD to be inside the CCDunit, the following prompts appears:

. 1DDS Qui i

@™y The D Currently in the CO-ROM drive has the same label as the 0 "40L_YER_30"
\\") which is in CCO unit "UNIT-04",
It may be & duplicate. Do you want to create a new record?

fes Mo I
If you wish to add this new CD to your database click ‘Yes’. This will

initiate the ‘Add New CD’ wizrd.
10.5. Messages
10.5.1. ‘A CD is present in the CCD Slot’ Message

DDS Meszage

A CD iz present in CCD Unit 01A's Slot. To continue please remove/insert it.

This message indicates that there is a CD in the CCD slot waiting to be
removed or inserted. No other C'C’D operations will be performed whilst the
unit is in this state.

10.6. Errors

CCD Unit "01A" Move Error

Q An errar has occurred while the unit was moving.

10.6.1. General Move Error

This error occurs when the CC’Dunit cannot move to the requested position.
It may be caused by a loose power or communications connection, or if a CD
is inserted whilst the unit is seeking a CD. If this error persists, your unit
may require servicing.
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10.6.2. Volume Information Error

i DDS Message x|

Unable to recognise this AUDIO C0, because Audio Device Driver is in use,
Close any program using the audio device driver (e.q. CD Player, ‘Windmp)
then press Retry,

Retry | Cancel i

This error occurs when the volume information of a CD in the CD ROM
drive of the computer cannot be read. This is usually limited to Windows 95
and 98, which prevent DDS from reading an audio CD while it is being
played. If you receive this error, close any programs that may be accessing
the CD-ROM drive (such as CD player) and click Retry.

To prevent this error from occurring, you may turn off the Automatically
detect CD in CD-ROM feature in DDS Options.

10.6.3. CD In Slot Move Error

CCD Unit “01A" Move Error x|

e A CD is present in the unit's slot, Please remave it

This error will occur if a CD or other object is inserted into the slot while the
unit is moving. The current operation will abort. Remove the obstruction and
attempt the operation again.

10.7. Database Corruption

Database corruption may occasionally occur as a result of incorrect operation
or disk degradation. If a problem is detected, DS tries to resolve it
automatically by restoring a backup and then asking the user to Verify All
Empty Slots.

10.8. Re-installing the Software

Re-installing DDS will cause your database to be overwritten! Before
undertaking a re-installation, ensure you backup your database.

Before re-installing, you should terminate your copy of 2D0S.
After re-installation is complete, restore the backup you have made.
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11. Terminating the Software

To terminate DS (ie. remove it from the system tray), click the right mouse
button on the DS ICON in the system tray. A popup menu appears with
the options Open and Exit. Select Exit if you want to terminate the DS
program, or you may select Open to display the 205 main screen.

When the exit menu option is selected the following dialogue appears on the
screen:

DDS Warning = ..E:- ]

Warning : Exiting DDS will disable pour CCD unit(z).
- ! Are pou sure 7

Start DDS nest time Windows is restarted;

Ve Mo |

If you do not wish 2DSto automatically restart next time Windows starts,
clear the ‘Start DDS next time Windo ws is restarted’ check box.

W using Windows N7, Windows 2000, or Windows XP you will need
administration rights to prevent DDS from loading at Windows start-up.
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Appendix 1: Troubleshooting

Problem Solution

I receive the “An error has
occurred while the unit was

moving” Error. What should I
do?

Check the CCPDunit’s CD slot for obstructions and
try again.

Check the power and communications connections
to the CCDunit and the computer and try again.

Turn the CCPDunit’s power off for ten seconds and
then on and try again.

Turn the CCPDunit’s power off for ten seconds and
then on, reset the computer, and try again.

If the above procedures do not solve this situation
your CCDunit may require servicing.

I know a CD is in the CCDbut it
s not in the DD database. How
do I get it out?

Open the 2DS Dialogue.

Select the Tools menu

Select Verify All Empty Slots.

The CCPDunit then will move to all the slots that

are not marked as used in the database, and try to
eject.

I have removed a CD from the
CCDunit but the database still
thinks in is inside the unit.

Open the 2DS Dialogue.
Select the CD from the list.
Select the eject button.

Select yes when prompted ‘Is the CD out of the
Unit?’
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Problem Solution

A CD has become stuck in the Turn the C'CDunit’s power off.
slot. Canl pull it out?

Carefully pull the CD out of the slot.

Turn the CCD unit’s power back on.

Restart your computer.

The DDS software may not recognize that the CD

has been removed. See the previous Trouble
Shooting item.

The DDS software does not Turn the CCDunit’s power off and make sure that

detect my CCDunit. What the connections are secure.
should I do?
Turn the CCPDunit’s power back on and try the

DDS software again.
Restart your computer and try again.

Reinstall the DS software and try again.

If the software still does not detect the unit you
may have a faulty cable or CCDunit.

For the latest information and other Troubleshooting solutions please check
our website at:

WwWw.projecthb.net
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Appendix 2: System Requirements

In order for your CCP unit and DS software to operate correctly, please
ensure that your PC meets the following mmmimum system requirements:

e A Pentium processor or better and;

e Atleast 1 MB of free disk space (more may be required for database
usage) and;

e Atleast 20 MB RAM (more may be necessary for some operating
systems) and;

e  Windows 95 (no USB support available) or;

e  Windows 98 (including SE) or;

e  Windows Millennium Edition (ME) or;

e  Windows NT 4 or later (no USB support available) or;
e  Windows 2000 Professional or

e  Windows XP (Home or Professional).
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